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1 序論

1.1 背景

1.1.1 系外惑星発見の歴史

1995年 10月太陽以外の主星とし、その周りを周回する太陽系外惑星 (以下、系外惑星) の発見が認められ

た。世界初の系外惑星の発見から約 20年を経た。2017年 12月時点までに様々な方法により、約 3,500個の

系外惑星が発見されている。Fig. 1.1はこれまでに発見された系外惑星の累積分布である。

Fig. 1.1 系外惑星の累積発見数 [1]

Fig. 1.1から系外惑星の発見数は指数関数的に増加していることがわかる。特に 2014年には 715個、2016

年には 1285個の系外惑星の存在が確定した。

発見方法について、Fig. 1.1に書かれているものを述べると上からドップラー法、トランジット法、マイク

ロレンズ法、直接撮像法、TTV法 (Transit Timing Variation)、Orbital Brightness Modulation、アストロ

メリ法となる。ここで発見法の分類について説明する。系外惑星の発見手法は大きく直接法と間接法に分類さ

れる。直接法とはその名の通り、系外惑星を直接観測することであるが、惑星は自分自身では光っておらず、

主星の反射光のみで光るため非常に暗く太陽系外での直接検出は困難である。前述の方法では直接撮像法が直

接法に分類される。またそれ以外の方法は惑星が原因で起こる現象を捉える方法が間接法である。以下、本論

文で取り扱う間接法の一つであるトランジット法について説明する。

1.1.2 トランジット法

系外惑星を間接的に観測する方法の一つにトランジット法がある。トランジット法とは視線方向にある惑星

が恒星を横切ることによって等級変化を引き起こす現象を捉える方法である。Fig. 1.2にトランジット現象の

概念図を示す。黄色の円は主星、黒色の円は惑星、楕円はケプラー運動する惑星の軌道を表している。トラン

ジット現象を観測することについて、ホットジュピターと呼ばれるような 1木星半径程度の系外惑星をとらえ

る場合、地上観測を行うと典型的には約 1%程度の減光率を観測することができる。また対象となる主星の半

径が別の方法で求められていると仮定するとき、トランジット現象による減光率から系外惑星の惑星パラメー

タを求めることができる。さらにトランジット法の拡張として、トランジットの分光観測により系外惑星の大

気の主成分を特定、ロシター－マクローリン効果による順行惑星か逆行惑星の判別、トランジット時間変動
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Fig. 1.2 トランジット現象の概念図

(TTV)による系外惑星の発見などが期待されている。現在でも、トランジット法は系外惑星の発見には欠か

せない方法の一つである。

1.1.3 系外惑星トランジット探査衛星

トランジット法は天体からの光に依存した観測方法である。その光は地上観測をする場合は大気を通過して

しまうため、散乱やゆらぎによる誤差が生じる。宇宙に系外惑星探査専用の人工衛星を打ち上げることによ

り、大気による誤差を考慮しない測光観測が可能となる。系外惑星探査衛星は一つの天体を集中的に観測を行

うことをせず、小口径で広視野な専用望遠鏡で自動的に掃天サーベイすることが現在の系外惑星観測における

主流となっている。しかし、そのような自動的な掃天観測には偽陽性が含まれる。その原因には (1)背景星と

混ざった食連星、 (2)部分食連星,、(3)電子収縮圧で支えられた惑星サイズの食、が考えられている。軌道上

自動掃天観測により検出されたトランジット信号は順次、系外惑星候補とされるが、地上観測での超精密測光

による軌道上自動掃天観測のフォローアップが不可欠となる。このフォローアップで観測され系外惑星である

と断定された場合、初めて系外惑星の発見とされる。軌道上観測による系外惑星トランジット観測専用の人工

衛星は今後とも打ち上げが予定されており、多数の系外惑星の発見が期待されている [2]。

すでにスペース観測が始まっているプロジェクト、また予定されているプロジェクトを以下に紹介をする

[2]。

• Kepler

宇宙望遠鏡 Keplerは、恒星のハビタブルゾーン近傍にある地球サイズの惑星の存在頻度を決定する

目的で 2009年に打ち上げられた系外惑星探査ミッションである。また NASAで最初の系外惑星探査衛

星である。観測領域の中心は、はくちょう座一カ所のみである。その領域にある 15万個以上の主系列

星の明るさを連続的かつ同時にモニターする。搭載されている望遠鏡は口径 0.95mのシュミット望遠

鏡である。また CCDカメラは、2200×1024素子の CCDを 42個並べて約 100平方度をカバーしてい

る。波長領域は 0.435-0.845 µmを量子効率 50%で測光観測する [3]。

• K2ミッション

Keplerは 2013年 8月に、搭載されていたジャイロが故障し姿勢制御が困難になった。そのため超精

密な系外惑星の測光を断念した。現在では主に黄道面に沿った多領域の観測に変更された。これを K2

ミッションと呼んでいる。

• TESS

TESS(Transiting Exoplanet Survey Satellite)は NASAによる Kepler衛星の次に採択された系外

惑星トランジット観測用の探査衛星であり、2018 年 3 月に打ち上げ予定である。観測領域について

Keplerのように一カ所の星座のみを集中的に観測するのではなく、全天のサーベイを行う。全天サーベ

イの方法として 24◦ × 96◦ の帯状の領域を 27日かけて観測し、その後衛星の方向を 27度東に向けて隣

4



の領域を観測しそれを 1年間行うことにより半球を観測する。さらに別の半球を 1年間同じ観測を行う

ことにより全天の観測を可能としている。よって TESSは 2年間の観測を行う。全天サーベイを行う際

の観測対象は 12等級より明るい FGKM型星である [4]。

• PLATO

PLATO(PLAnetary Trabsits and Oscillation of stars)は ESAが 2024年の打ち上げを提案してい

る可視光トランジット衛星計画である。34台の小型望遠鏡と 48.5◦ × 48.5◦ のカメラを搭載している。

合計 100万個以上の恒星を観測する。

1.2 目的

1.1.3項でも述べたように TESSや PLATOといった系外惑星探査衛星による自動サーベイ観測によって系

外惑星候補が今後とも増加すると予想され系外惑星の発見が今後も期待される。将来的に系外惑星の確定を継

続するために高知工科大学での観測環境の構築を目指すことを目的とする。しかし、天文学に関する研究設備

を保有していない高知工科大学では天文学的精密観測の試みは初めてとなる。そのため外部機関である岡山大

学に設置されている望遠鏡設備を利用しトランジット法による系外惑星を観測し、得られた観測データから測

光解析を学ぶことを目的とする。
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2 観測

2.1 観測手法

2.1.1 観測対象の決定方法

系外惑星は現在 3,500 個以上確定されている。その中で追観測の候補天体を選定するには一般公開されて

いるデータベースを利用するとよい。今回利用したデータベースは ETD(Exoplanet Transit Database)[5]で

ある。ETDはすでに観測されている系外惑星トランジットを素早くかつ簡単に検索することができるデータ

ベースである。利点は、日付、観測地経緯度を指定することによりデータベースに格納されている系外惑星の

名前、トランジット開始時刻、トランジット中央時刻、トランジット終了時刻とそれらの時刻に対する天体の

高度、トランジット継続時間、V等級、トランジット深さ、座標 (赤経、赤緯)の情報が一目で判断できる。実

際には取り扱う望遠鏡、CCDカメラやその土地における光害状況などを考え、さらに条件を絞る必要がある。

次に条件の絞り方を述べる。

• 等級は V < 11.5 となる天体

望遠鏡の極限等級M は次の式で計算される [6]。

M = 5 log10 ϕ+ 1.774 (1)

ただし、ϕは有効径 (mm)である。本研究で使用した望遠鏡の有効径は 356mmであるから、極限等級

は 14.5等級として計算できる。しかし実際は大気揺らぎやカウント値を考慮した誤差により比較的暗

い天体を測光することが難しい。ここでカウント値とは 1ピクセルに蓄積される光量のことである。そ

のため 11.5等級よりも明るい天体を観測対象とした。

• 天頂角が 60度以下

天頂角が大きくなる場合、天体からの光の大気通過距離が大きくなる。その分だけの大気揺らぎが大

きくなるため、天頂角が小さくなるような天体を選択した。

• 比較星がある
3.2節で述べるように本研究では相対測光を行うため、比較星が必要である。本研究で撮影される視

野範囲 (FOV: Field of View) は 0.5◦ × 0.5◦ であるり、その範囲に比較星が入っていなければならな

い。また比較星が多くとれるほど特定の比較星に起因するのノイズが除去される。そして比較星は対象

星と同じもしくは明るいほどよいとされている [7]。

2.1.2 観測対象の詳細

2.1.1の条件で決定し、本研究で観測を行った既知の系外惑星と恒星の詳細を述べる。

• KELT-7 b

初めに KELT(The Kilodegree Extremely Little Telescope) とは、アメリカのアリゾナ州に位置す

るM.Winer Memorial Mobile Observatoryが、北の空にある 8 < V < 10　等級の天体に対し木星と

似た惑星をトランジット法によって発見することを目的としたプロジェクトである。その観測範囲の視
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野は 26◦ × 26◦ であり、北の空の 25％を占めている。実際ドップラー法では V～8等級より暗い惑星

を検出することが難しいとされており、この等級より暗い等級を見つけるにはトランジット法が適して

いるとされている。KELTプロジェクトで発見された系外惑星の一つとして KELT-7 bがある。ここ

では KELT-7 bについての既知の惑星パラメータ、主星パラメータを以下に示す [8]。

Fig. 2.1 KELT-7と比較星

Table 2.1 KELT-7(GSC 2393-00852)　恒星パラメータ

パラメータ 単位 値

等級 magnitude(V-band) 8.540± 0.030

質量M M⊙ 1.535+0.066
−0.054

半径 R R⊙ 1.732+0.043
−0.045

赤緯 +33◦19m5.4 s

赤経 5 h13m10.9 s

Table 2.2 KELT-7 bの既知の惑星パラメータ

パラメータ 単位 値

公転周期 P days 2.7347749± 0.0000039

長径 a AU 0.004415+0.00062
−0.00052

質量M MJ 1.28± 0.18

惑星半径 R RJ 1.533+0.0046
−0.047

ここで Table. 2.1のM⊙、R⊙ は太陽質量、太陽半径であり、Table. 2.2のMJ、RJ は木星質量、
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木星半径である。

• XO-6 b

XO-6 bは XOプロジェクトにより 6番目に発見された系外惑星である。XOプロジェクトとは XO

望遠鏡とよばれる既製品で製作された口径 200mm の 2 つの望遠鏡を用いて系外惑星を発見するプロ

ジェクトである [9]。XO-6の恒星パラメータを Table 2.3、XO-6 bの惑星パラメータを Table 2.4にそ

れぞれ示す [10]。

Fig. 2.2 XO-6と比較星

Table 2.3 XO-6(GSC 04357.00995)　恒星パラメータ

パラメータ 単位 値

等級 magnitude(V-band) 10.25± 0.03

質量M M⊙ 1.47± 0.06

半径 R R⊙ 1.93± 0.18

赤緯 +73◦49m39.7 s

赤経 6 h19m10.39 s
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Table 2.4 XO-6 bの既知の惑星パラメータ

パラメータ 単位 値

公転周期 P days 3.7650007± 0.0000081

長径 a AU 0.0815± 0.0077

質量M MJ < 4.4

惑星半径 R RJ 2.07 ± 0.22

• GJ436 b

GJ436 はグリーゼ近傍恒星カタログに収録されている恒星である。グリーゼ近傍恒星カタログとは

太陽系近傍の星表である [11]。GJ436 の恒星パラメータを Table 2.5、GJ436 b の惑星パラメータを

Table 2.6にそれぞれ示す [13][14]。

Fig. 2.3 GJ436と比較星のライトフレーム

Table 2.5 GJ436(GSC 1984.01926)　恒星パラメータ

パラメータ 単位 値

等級 magnitude(V-band) 10.67± 0.01

質量M M⊙ 0.47± 0.07

半径 R R⊙ 0.455± 0.018

赤緯 +26◦42m23.7 s

赤経 赤経：11 h42m11.09 s

ここで Table. 2.6についてME、RE は地球質量、地球半径である。
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Table 2.6 GJ436 bの既知の惑星パラメータ

パラメータ 単位 値

公転周期 P days 2.64388312± 0.00000057

長径 a AU 0.0291± 0.0015

質量M ME 22.1± 2.3

惑星半径 R RE 4.170± 0.168

2.2 観測機材

本研究のトランジット観測で主に使用した観測機材、ソフトウェアを以下に示す [18]。

Table 2.7 観測機材一覧

機材 製品名 備考

望遠鏡 MEADE LX600-35F8ACF 有効径:356mm, 焦点距離: 2,845mm, F値: F8

ドーム 協栄産業製 直径: 3m

CCD SBIG STL-1001E Kodak KAF-1001E NABGを使用

フィルター Kasai UHC フィルター，Kasai OIII フィルター V-bandを使用

パソコン windows10

Table 2.8 観測に使用したソフトウェア一覧

ソフトウェア名 備考

ステラナビゲータ 10 望遠鏡の操作に使用

CCDOPS CCDの操作に使用

2.2.1 岡山大学理学部望遠鏡

系外惑星の観測データを得るために今回は岡山大学理学部望遠鏡の設備を利用した。岡山大学理学部望遠

鏡は校舎の屋上に設置されており、経度: 133 h55m21.4 s、緯度: 34◦41m19.1 s に位置している。望遠鏡は

MEADE LX600-35F8ACF を使用している。有効口径は 356mm、焦点距離は 2, 845mm、F 値は F8 であ

る。

2.2.2 冷却 CCDカメラ

本研究では CCD カメラは SBIG STL-1001E を使用した [17]。Fig. 2.5 は SBIG STL-1001E の外観の画

像であり、特に Fig. 2.5の左に示した CCDカメラが本研究で使用した Kodak社製の KAF-1001E・NABG

である。

CCD素子は 24.6× 25.6mm、1024× 1024画素を備えている。また空冷時は −40 ◦Cまで冷却する能力を

もつ。またジョンソンフィルターを備えており、B,V,R,Iバンドを指定可能である。本研究では可視光の範囲

とされる Vバンドフィルターを使用した。2.6はジョンソンフィルターの波長に対する量子効率である [15]。

緑の曲線が Vバンドによる量子効率であり、約 530 nmに約 85%のピークをもつ。
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Fig. 2.4 岡山大学理学部望遠鏡　撮影日時：2017年 6月 10日

Fig. 2.5 STL-1001E。左が本研究で使用した KAF-1001E・NABG。右が TI社製 TC-237H・ABG

Fig. 2.6 ジョンソンフィルターの分光感度特性
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2.2.3 CCDノイズ処理

CCDにはさまざまなノイズが存在する。この章では本研究で処理をしたダークノイズ、フラットフィール

ドによるノイズについて述べる [16]。

• ダークノイズ
重要なノイズとして露出しなくても熱が発生し電流が流れてしまう暗電流ノイズがある。そして暗電

流をクリアしたとしても発生するノイズに読み出しノイズがある。読み出しノイズは電荷転送、電荷信

号の増幅、スイッチングにより電気回路で発生した電気的ノイズのことである。暗電流ノイズ、読み

出しノイズのことを光が当たらなくても存在する輝度情報という意味でダークノイズと呼ばれている。

ダークノイズは露出時間と CCDの温度に比例して増加する特性をもつ。そのため露出時間を短くする

か、CCDの冷却を行うことで暗電流ノイズを減少させる工夫が必要である。しかし露出時間が増える

ほどカウント値が増加するのでカウント値の飽和状態手前まで露出したいため、露出はその天体のカウ

ント値に依存した時間を考えなければならない。それなのでダークノイズの除去には CCDを冷却する

ことを優先させるべきである。ダークノイズについて −100◦Cほどで暗電流ノイズが無視できる状態に

できるが、読み出しノイズは除去しきれないとされている [16]。しかし本研究で使用したKAF-1001E・

NABGは冷却性能は最大 −40◦Cまでである。これより本研究では冷却温度を −30◦Cに設定した。

• 感度ムラによるノイズ
CCDの各ピクセルには光学系による周辺減光、付着しているゴミのボケた像、ゴースト、フレアな

どのムラの情報が含まれている。測光をする際にムラがあった場合はムラに依存した星像が得られてし

まう。それなので高精度な測光結果が得られない。

• フラットフィールドの撮影方法
感度ムラのノイズを除去するためにフラットフィールドを撮影する。撮影方法はフラットフィールド

の撮影方法ここで設置したアクリル板に付着しているゴミ、望遠鏡のレンズ、鏡に付着しているゴミが

撮影されることがある。そのため、アクリル板を回転させて撮影を再び行い、回転させた複数枚のフ

ラットフィールドについて解析で各ピクセル毎に輝度の中央値 (メディアン) をとることにより付着し

ているゴミが写らないフラットフィールドを作成することができる。

またフラットいフィールドにも当然ダークノイズが含まれているのでフラットフィールドと同じ露出

時間でダークフレームを複数枚の撮影をする。

2.2.4 観測手順

岡山大学理学部望遠鏡を用いて系外惑星のトランジット観測を行うため、以下の手順で実験を行った。

(1) ドーム

岡山天体理学部望遠鏡はドーム設備の中に設置されている。観測を行うためドームを開け、観測のた

めの望遠鏡の入集運動追尾とドームは同期して動かないため、観測中は望遠鏡の向く方向に合わせて適

宜ドームを手動で動かす必要がある。

(2) 望遠鏡と CCDカメラの取り付け、CCDカメラの冷却

望遠鏡の接眼部に今回使用した ST-1001Eを取り付けた。CCDカメラの冷却温度は −30◦Cとした。
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Fig. 2.7 岡山大学理学部望遠鏡のドーム　撮影日時：2017年 6月 10日

(3) 望遠鏡、CCDカメラとパソコンの同期

望遠鏡制御はステラナビゲータ 10上で行った。CCDカメラの撮影設定は CCDOPSを使用した。

(4) アライメントと焦点合わせ

ステラナビゲータ 10上の座標と天球 (望遠鏡の方向)の赤緯経を同期させるため、初めに 1等級～2

等級の天体を視野内に入れて同期させた。そのとき 4等級程度の比較的暗い星がわかるように望遠鏡上

の焦点を合わせた。その後、ターゲットと比較的近く明るいの天体を狙い、焦点を合わせた。この操作

を 10等級～といったターゲット星の等級が十分に撮像できる程度まで繰り返した。

(5) ターゲットを視野に入れる

(4)で焦点が合った後、ターゲットの赤緯、赤経からターゲットを視野に入れる。このとき、事前に

用意した星図とパソコン上で起動しているステラナビゲータ 10を参考にした。

Fig. 2.8は XO-6 bの観測を試みたときにスクリーンショットでとった画像である。緑色のレチクル

中心の点がステラナビゲータ 10上でのターゲットである。

(6) 焦点ぼかしと露光時間の決定

本観測で得られた後の測光解析では、カウント値が積分によって得られる。また露光しすぎればサ

チュレーションを引き起こすし測光不能となるため、十分な輝度で測光可能な天体に対しては、やや焦

点をぼかしつつ、できるだけカウント値を稼いだほうがよい。そのため焦点をぼかしサチュレーション

が起こらない程度まで露光時間を決定する。ただし、ターゲットの周りに星像があった場合測光すると

きにその星像も積分する。周りの星像が近すぎないことを確認した後焦点をぼかすのがよい。

(7) ライトフレームの撮影

(6)で焦点と露光時間を決定した後、撮影枚数を決定して撮影を開始した。

(8) ダークフレームの撮影

冷却温度をライトフレーム撮影時と同様の状態を保ったままダークフレームを撮影する。CCDOPS

上の Filter Setup で「no filter」の設定を選択することにより CCDカメラの機構上でシャッターが閉
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Fig. 2.8 ステラナビゲータ 10上での操作画面の例

まるため、ダークフレームが撮影できる。ダークフレームの露光時間はライトフレームを撮影した露光

時間、フラットフィールドを撮影する露光時間の 2セットを撮影した。

(9) フラットフィールドの撮影

フラットフィールドの撮影では乳白色のアクリル板を用いた。ドームを閉じ、望遠鏡を天頂に向け、

そのうえに乳白色のアクリル板を載せた (Fig. 2.9)。また望遠鏡の両側に卓上ライトを壁側に向け、散

乱光によりドーム内の照明が均一になるようにした。フラットフィールドの露光時間は 5秒とした。ま

た望遠鏡のレンズ、アクリル板にはゴミが付着している。そのため、アクリル板の位置を 3回異なる位

置に変更しそれぞれ撮影した。

Fig. 2.9 乳白色のアクリル板の設置
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Fig. 2.10 卓上ライトの設置

2.2.5 観測ログ

今回、一連の観測と測光解析ができたターゲットは KELT-7, XO-6, GJ436の 3例であった。初めに 2017

年 11月 20日の観測した KELT-7の観測ログを Table. 2.9に示す。

Table 2.9 KELT-7　観測ログ

CCD温度 フィルタ 枚数 積分時間 (秒)

ライトフレーム　 −29.7◦ V 354 25

ダークフレーム (ライトフレーム用)　 −29.7◦ なし 11 25

ダークフレーム (フラットフレーム用)　 −29.7◦ なし 11 5

フラットフィールド −29.7◦ V 33 5

次に 2018年 1月 17日に観測した XO-6の観測ログを Table. 2.10に示す。

Table 2.10 XO-6　観測ログ

CCD温度 フィルタ 枚数 積分時間 (秒)

ライトフレーム　 −29.7◦ V 436 25

ダークフレーム (ライトフレーム用)　 −29.7◦ なし 11 25

ダークフレーム (フラットフレーム用)　 −29.7◦ なし 11 5

フラットフィールド −29.7◦ V 33 5

Table. 2.10について、ライトフレームの枚数については雲の出現により観測日の 26時 2分 (翌日 2時 2分)

に観測を中断時点までの数を示す。

次に 2018年 1月 19日に観測した GJ436の観測ログを Table. 2.11に示す。
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Table 2.11 GJ436　観測ログ

CCD温度 フィルタ 枚数 積分時間 (秒)

ライトフレーム　 −29.7◦ V 214 60

ダークフレーム (ライトフレーム用)　 −29.7◦ なし 11 60

ダークフレーム (フラットフレーム用)　 −29.7◦ なし 11 5

フラットフィールド −29.7◦ V 33 5

3 解析

3.1 一次処理

天体画像を撮影した生画像のことをライトフレームと呼ぶ。ライトフレームを解析する際、ライトフレーム

にはさまざまなノイズが含まれている。解析する前に処理を行う一般的な処理プロセスを一次処理と呼ぶ。今

回の解析ではこれらの処理を手動で行ったため、特に一次処理のダーク補正、フラット補正について説明する。

3.1.1 ダーク補正

2.2.3項より−30◦Cの冷却ではダークノイズを無視することができないが、ダークフレームを用いた画像処

理によりノイズを消去することが可能である。ダークフレームには暗電流ノイズ、バイアス、読み出しノイズ

の 3種類のノイズ情報が含まれているため、ライトフレームからダークフレームを画像処理的に減算すれば、

ライトフレームから 3種類のノイズ情報が除去される。この処理をダーク処理と呼ぶ。今回は FIJIと呼ばれ

るソフトウェアを用いて行った [22]。ダーク処理には、1.ライトフレームのダーク処理、2.フラットフィール

ドのダーク処理の 2つを行う必要がある。ここでは 1.ライトフレームのダーク処理の操作を述べる。

(1) FIJIを開く

(2) File → Import → Image Sequence...を選択する

(3) ダークフレーム画像が保存されたディレクトリ (フォルダ)を選択する

(4) Sequence Optionsにて、「Use virtual stack」にチェックを入れ、OKをクリックすると複数の画像が

選択されているウィンドウが開く

(5) Image → Stacks → Z projectを選択

(6) Projection typeは「Median」を選択し、OKをクリックする

(7) File → Save As → FITS...　を選択し、名前を決めて「Save」をクリックし、中央値をとった画像を

保存する

ダークフレームは各画素の輝度が 0に近いので画像を目視しただけでは撮影したダークフレームの元画像と

中央値をとったダークフレームを比較することが困難である。また FIJIで行われている中央値の計算処理は

ブラックボックスのため、実際に妥当な中央値が取れているかを測光解析により確かめる。ダークフレームの

解析方法を次に示す。この解析にはすばる画像解析ソフトMakali’iを使用した (Fig. 3.1)[19]。

(1) Makali’iを開く

(2) タブにある「開く」より撮影したダークフレーム画像を選択する

(3) タブにある「測光」より測光モードの選択から「矩形測光」を選択する

(4) ダークフレーム全体をドラッグして選択する

(5)「出力：」より「テキスト出力」をクリックすると.csvファイルが保存される。
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Fig. 3.1 ダークフレームのカウント値に対する測光解析

Fig. 3.1においてダークフレームの外枠の黄色の枠が選択範囲である。選択範囲について今回撮影された画像

は 1024× 1024ピクセルなのでその範囲を指定した。
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3.1.2 フラット処理

2.2.3項より光学系が引き起こす感度ムラを画像処理で補正する必要がある。その処理はライトフレームか

らフラットフィールドを除算すればよい。この処理のことをフラット処理という。ここでフラットフィールド

にもダークノイズが含まれているため、まずはダーク処理を行う必要がある。この処理はMakali’iを用いて行

う。

(1) Makali’iを開く

(2) データ 1次処理 → バッチ「共通 [バイアス・ダーク・フラット]」を選択する

(3)「リストに追加」をクリックして、フラットを撮影した FITS画像を複数選択する

(4)「ダーク補正」より FIJIでダーク処理したフラットフィールド用のダークフレーム画像を選択する。こ

こでフラットとバイアスのチェックを外し、OKをクリックする

Fig. 3.2 フラットフィールドからダーク処理

上述の操作によりダーク処理を行ったフラットフィールドが作成される (Fig. 3.2)。次に FIJIによりフラッ

トフィールドの中央値をとる。乳白色アクリル板を 3回移動しているため、3セットのフラットフィールドが

撮影されている。そのため、1セットごとに中央値をとる [23]。

(1) FIJIを開く

(2) File → Import → Image Sequence...を選択する

(3) ダーク処理をしたフラットフィールドのディレクトリを選択する

(4) Sequence Optionsにて、「Use virtual stack」にチェックを入れ、OKをクリックと複数の画像が選択

されているウィンドウが開く

(5) Image → Stacks → Z projectを選択

(6) Projection typeは「Median」を選択し、OKをクリックする

(7) File → Save As → FITS...　を選択し、名前を決めて「Save」をクリックし、中央値をとった画像を

保存する

(8) アクリル板の位置を 3回異なる位置に変更しているので 3セットのフラットフィールドが存在している

ので、それぞれの 1セットごとに中央値をとる。3枚の中央値をとったフラットフィールドができるの

で、再び (2)から (7)の操作により中央値を作成する

(9) フラットの規格化: Analyze → Measure を選択し、Resultsの中のMeanの数値をメモしておく
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(10) Process → Math → Divide...を選択し、メモしたMeanの値を入力する。その後 OKをクリック

3.1.3 一次処理

最後にライトフレームのダーク処理とフラット処理を行う (Fig. 3.3)。

(1) Makali’iを開く

(2) データ 1次処理 → バッチ「共通バイアス・ダーク・フラット」を選択する

(3)「リストに追加」をクリックして、フラットフィールドを複数選択する

(4)「ダーク補正」より FIJIでダーク処理したライトフレーム用のダークフレーム画像を選択。そして「フ

ラット補正」において FIJIでダーク処理したフラットフィールドを選択。ここでバイアスのチェック

を外し、OKをクリックする

Fig. 3.3 ライトフレームの一次処理

3.2 測光方法

3.2.1 Makali’iによる測光方法

得られた観測データを解析するソフトウェアとして本研究では、すばる画像解析ソフト Makali’iを主に使用

した。また測光を行うための補助として AstroImageJ[20]を使用した。Makali’iは国立天文台が開発し一般利

用可能なソフトウェアですばる望遠鏡をはじめとした研究用観測で得られた FITS形式の画像を解析すること

ができる。AstroImageJは FITS画像の閲覧ができるソフトウェアであるが、測光する際に星像の半径や Sky

半径 (背景光) を決定するために用いた。本項では Makali’i および AstroImageJ を用いて行った処理手順を

示す。

• AstroImageJ AstroImageJで星像の半径や Sky半径を調べる手順を述べる。

(1) AstroImageJ を起動する

(2) File→open より FITS画像を選択する

(3) 測光半径を調べたい天体に　 Altキー +左クリック をすると、星像のカウント値における空間分

布が現れる (Fig. 3.4)

(4) このグラフに現れている Radius, Back>, <Back のピクセル値を Makali’i 上の以下の処理で用

いる

• Makali’i Makali’iでの測光の手順を述べる [21]。
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Fig. 3.4 AstroimageJによる星像の空間分布

(1) Makali’iの起動

(2) ファイル→開く　より FITS画像を選択する

(3) バーから「測光」を選択し、「開口測光」をクリックする

(4) 測光半径を「半自動」にする。半径設定が編集できるようになるので、AstroImageJで調べられた

各パラメータに対し、Radius→恒星径、Back> −Radius→SKY内径に値を入力する。ただし −
は値の引き算を表している。ここで Makali’i の仕様上、恒星径 <SKY 内径の設定にはできない。

よって SKY内径には Radius+1の値を入力した (Fig. 3.4)

Fig. 3.5 Makali’iによる測光の設定
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(5) 画像上にカーソルを置くと円状のカーソルが表れるので、観測対象となる天体と比較星となる天体

に対しおおよそ中心をクリックするとそれぞれの天体についての測光カウント値が表れる。このカ

ウント値は光度曲線をプロットする際に使用する

(6) 測光を終えた後、「テキスト出力」で .csvに出力する

3.2.2 相対測光と絶対測光の光度曲線

(1) 相対測光と絶対測光

トランジット現象を観測する際の光度曲線を描くときは相対測光が用いられる。相対測光とは主星自

体のフラックスが一定である比較星とターゲット星のフラックス比をとり光度曲線を描く手法である。

相対測光はターゲット星と比較星の距離が十分に近い場合は地球大気の状態に依存しにくい測光が可能

である。

絶対測光は検出器の効率、ゲイン、望遠鏡光学系、装置内光学系すべての効率が既知、大気減光量が

既知であれば、検出したカウント値から天体の光量を決定することができる [24]。そのため大気の状態

に依存する測光となるため、トランジット現象を検出することには不向きであるが雲の通過や大気揺ら

ぎなどを検出することができる。

(2) ユリウス通日

光度曲線の横軸はユリウス通日 (Julian Day: JD) を使用した。ユリウス通日とは紀元前 4713 年 1

月 1日の正午 (標準時)を 0日目とした日数である。ユリウス通日を使用したのは天体観測は夜間に行

われることが多いため、夜間に日付が切り替わるのは不便であるためである。各観測時刻に対するユリ

ウス通日の計算には pythonの astropyモジュールを使用した [25]。

(3) 相対等級

光度曲線の縦軸は、ターゲットと比較星とのカウント値の比を等級に変換した値を使用した。カウン

ト値の比から等級に変換する式はポグソンの式を用いた。ポグソンの式を以下に示す。

m−M =
5

2
log10

Nt

Nc
(2)

ただし、mは比較星の等級、M はターゲット星の等級、Nt はターゲット星のカウント値、Nc は比較

星のカウント値である。

(4) 移動平均線

移動平均線は観測データに対して平滑化された曲線をプロットするために用いられる。移動平均線のプ

ロットには pythonの numpy.convolve関数を使用した [26]。

3.2.3 天体と Sky平均のカウント値の時間変化

今回の観測において地上観測のために気象変動、光害によるカウント値の変化を捉える必要がある。そのた

め、天体および Sky平均の絶対測光をすることによる気象変動の変化をグラフ化した。
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4 結果

4.1 ライトフレームの撮影結果

本実験で得られたライトフレーム、ダークフレームおよびフラットフィールドの生画像をを以下に示す。

Fig. 4.1 撮影した KELT-7 bのライトフレーム 露出時間: 25秒, 撮影時刻：2017年 11月 20日 22時 46分

Fig. 4.1に示す KELT-7 bのライトフレームでは、等級が比較的大きい天体については白い点として映ってい

るが、等級が小さい天体は黒色の点の周りに円環状にカウント値が分布していた。

Fig. 4.2の星像と Fig. 4.10の HWMW(Half Width at Half M aximum)について、ターゲットの近くに

星像がありフォーカスをぼかした際にその天体と XO-6のカウント値が合計され積分されるのと正確な測光に

影響するため、これを避けられる程度にぼかし具合を抑えたことが確認できた。そのため、Fig. 4.1と比較す

ると、Fig. 4.2では円環状にカウント値が分布している星像は目視の肉眼では確認できない。また全体的にラ

イトフレームを見ると、画面全体にわたるような淡い円環状の像が確認された。

次に、GJ436を観測した際に撮影したライトフレームを示す。

Fig. 4.3について XO-6のライトフレーム (Fig. 4.2)と同様に、円環状にカウント値が分布していることが

確認できず、比較的焦点があっていることが確認された。
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Fig. 4.2 撮影した XO-6 bのライトフレーム 露出時間: 25秒, 撮影時刻：2018年 1月 17日 21時 49分

Fig. 4.3 撮影した GJ436 bのライトフレーム 露出時間: 60秒, 撮影時刻：2018年 1月 20日 0時 3分

次に、撮影されたダークフレームを示す。Fig. 4.4のところどころのピクセルに白い点が確認された。これ

らの白い点のカウント値が様々な値となっていることが確認された。

撮影したフラットフィールドを Fig. 4.5に示す。Fig. 4.5では大き淡い黒色の円が写っており、ところどころ

に小さな黒色の円環があらわれていた。この黒色の円環は星像の焦点をぼかしたものとよく似ていることがわ

かる。
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Fig. 4.4 撮影したダークフレーム　露出時間: 25秒　撮影時刻：2018年 1月 18日 0時 42分

Fig. 4.5 撮影したフラットフィールド　露出時間: 5秒　撮影時刻：2018年 1月 18日 1時 12分

4.2 各フレームの解析結果と一次処理

4.2.1 ダークフレームの解析結果

ダークフレーム 11枚の中央値をとった結果を Fig. 4.6に示す。Fig. 4.4と同様にところどころのピクセル

に白い点が確認できた。しかし、撮影したダークフレームのうちの 1枚である Fig. 4.4とは肉眼では区別され

ない。そのため測光解析によりカウント値が Fig. 4.6とどれだけ変化したかを次の Table 4.1に示す。

Table. 4.1において medianによる平均カウント値は 109.0425720であり、おおよそ撮影番号 1から 11の中

央値をとっていることが確認された。
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Fig. 4.6 ダークフレーム 11枚の中央値をとった結果

Table 4.1 ダークフレームの各生画像と 11枚で中央値をとったダークフレームとカウント値

撮影番号 総カウント値 平均カウント値

1 113917197 108.6399050

2 114117682 108.8311024

3 115092197 109.7604723

4 114151422 108.8632793

5 115092971 109.7612104

6 115048903 109.7191839

7 115098081 109.7660837

8 112779160 107.5545883

9 113786038 108.5148220

10 113916563 108.6393004

11 114930976 109.6067200

median 114339424 109.0425720

4.2.2 フラットフィールドの解析結果

Fig. 4.7にフラットフィールド 33枚分について中央値をとった結果を示す。Fig. 4.5と比較すると全体的

にフラット上の画像パターンは変化していないが、その濃淡が変化していることがわかる。特に黒い円環の写

り方が少し明瞭になったことが確認できた。

4.2.3 ライトフレームと一次処理の結果

Fig. 4.8は一次処理を終えた XO-6の画像である。ライトフレームである Fig. 4.2と比較すると、Fig. 4.2

で写っていたフラット状の像がなくなっていることが確認された。
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Fig. 4.7 フラットフィールド 33枚から中央値をとった結果

Fig. 4.8 Fig. 4.2を一次処理をした結果
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4.2.4 一次処理されたライトフレームの星像の解析結果

次にどれだけフォーカスをぼかして撮像したかを調べるために星像のカウント値の分布を Fig. 4.9に示す。

Fig. 4.9 は横軸が星像中心からのピクセル数、縦軸がカウント値の分布である。 Fig. 4.8 の星像と Fig.

Fig. 4.9 KELT-7の星像の解析結果

4.10の HWMW(Half Width at Half Maximum)について、ターゲットの近くに星像がありフォーカスをぼ

かした際にその天体と XO-6のカウント値が合計され積分されるのと正確な測光に影響するため、これを避け

られる程度にぼかし具合を抑えたことが確認できた。ここで HWMWは正規分布といった分布の広がり具合

を表していいるので、フォーカスがどれだけあっているかの指標として用いている。Fig. ?? は HWHM が

5.55 なので、ある程度星像がボケていることがわかる。

次に XO-6の星像の解析結果を次に示す。

Fig. 4.10では HWHMは 1.73となっており、フォーカスが比較的あっている状態で撮影を行われたことが確

認された。

Fig. 4.11では HWHMは 1.63となっており、フォーカスが比較的あっている状態で撮影が行われたことが

確認された。焦点をあわせている理由は、このときの露出時間は 60秒であったたために星像を引きずること

と CCDのノイズの蓄積を防ぐためである。カウント値が約 110,000程度であったために焦点がぼかさなくて

も十分なカウント値が得られたためである。
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Fig. 4.10 XO-6の星像の解析結果

Fig. 4.11 GJ436の星像の解析結果
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4.3 光度曲線

本節に示すいずれのグラフにおいて、縦軸はターゲットと比較星の等級差、横軸はユリウス暦である。また

青色の丸印は観測結果で各時刻における測光結果のプロット、赤線は 10点の移動平均をつないだ線、縦軸と

平行な 2本の線のうち the startはトランジット予報によるトランジット開始時刻、the endはトランジット

終了時刻である。

KELT-7を観測した結果を次に示す。

Fig. 4.12 KELT-7の観測結果による光度曲線 (2017年 11月 17日)

Fig. 4.12において、トランジット開始直後にプロットが始まっているのは観測気候条件の問題ではなく、観

測装置の扱いに不慣れなための不手際により観測開始が遅れたことによる。トランジット開始時刻からトラン

ジット終了時刻において両端では相対等級は約 0.635 magであるが、2458078.09 JDから 2458078.18 JDで

相対等級は約 0.63を下回っていることがわかる。

またトランジット終了時刻以降では移動平均線が減少傾向になったことが確認された。
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Fig. 4.13に XO-6を観測した際の光度曲線の結果を示す。

Fig. 4.13 XO-6 bの観測結果による光度曲線 (2018年 1月 17日)

Fig. 4.13についてトランジット開始前のプロットでは相対等級は-0.98 magから-0.96 magを推移している

が、トランジット開始直後の 2458136.6 JD付近から極端に相対等級が落ちており、それ以降は測光解析が困

難となりプロットできなくなった。
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GJ436を観測した光度曲線の結果を示す。

Fig. 4.14 GJ436 bの観測結果による光度曲線 (2018年 1月 19日)

赤線は 10個のデータで平均した移動平均線である。Fig. 4.14について観測開始直後は約 0.02 mag付近で推

移しているが、トランジット開始直後は相対等級が-0.05 magから-0.10 magまで下がった。そしてそのデー

タの間は雲が出現しており、測光解析が行えなかった。その後は相対等級が-0.05 magから 0.15 magをまで

を推移しているが、雲が出現しており測光解析が行えないデータが多く存在した。
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4.4 カウント値の時間変化

4.4.1 天体のカウント値の時間変化

ターゲット星のカウント値の時間変化を Fig. 4.15、比較星 1のカウント値の時間変化を Fig. 4.16、比較星

2のカウント値の時間変化を Fig. 4.17にそれぞれ示す。ただし、比較星 1は Fig. 2.1の左の比較星、比較星

2は右の比較星である。

Fig. 4.15 KELT-7のカウント値の時間変化

縦軸はカウント値、横軸はユリウス通日である。Fig. 4.15 、Fig. 4.16、Fig. 4.17のグラフからどちらも時

間が経つにつれてカウント値は減少していたことがわかる。
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Fig. 4.16 KELT-7の比較星 1のカウント値の時間変化

Fig. 4.17 KELT-7の比較星 2のカウント値の時間変化

次に XO-6のカウント値の時間変化の結果を Fig. 4.18と比較星のカウント値の時間変化の結果を Fig. 4.19

にそれぞれ示す。

XO-6およびその比較星のカウント値は約 197000、約 480000を推移していたが、トランジット開始の予報

時刻の 2458136.6 JDあたりから雲が出現したことが原因で極端にカウント値が減少した。その後は星像が見

えなくなり測光解析が不可能となった。

次に GJ436のカウント値の時間変化の結果を Fig. 4.20と比較星の時間変化の結果を Fig, 4.21にそれぞれ示

す。

GJ436のカウント値は約 130000を推移していたが、トランジット予報時刻の少し手前の 24581381.05 JD
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Fig. 4.18 XO-6のカウント値の時間変化

Fig. 4.19 XO-6の比較星のカウント値の時間変化
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Fig. 4.20 GJ436のカウント値の時間変化

Fig. 4.21 GJ436の比較星のカウント値の時間変化
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から薄い雲が表れ、カウント値が減少した。その後カウント値は上下を繰り返し、50000から 150000の範囲

で推移した。トランジット継続中の時刻にもカウント値は大きく変動していた。比較星も同様の傾向があるこ

とが確認できた。
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4.4.2 Sky平均のカウント値の時間変化

ターゲット周りの Sky平均のカウント値の時間変化を Fig. 4.22、比較星 1周り Sky平均のカウント値の時

間変化を Fig. 4.23、比較星 2周りの Sky平均のカウント値の時間変化をそれぞれ示す。

Fig. 4.22 KELT-7周りの Sky平均のカウント値の時間変化

縦軸は Sky平均のカウント値、横軸はユリウス通日の日付である。Fig. 4.22、Fig. 4.23、Fig. 4.24のグラ

フからいずれも観測開始からカウント値は天体自身のカウント値と比較して急激に減少した。約 2458078.17

JDあたりからカウント値は約 290の一定値をとり、約 2458078.22 JD付近でカウント値の一時的な減少が起

こった。その後カウント値は元の一定値 (約 290)に戻った。
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Fig. 4.23 KELT-7における比較星 1周りの Sky平均のカウント値の時間変化

Fig. 4.24 KELT-7における比較星 2周りの Sky平均のカウント値の時間変化
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次に XO-6の周りの Sky平均のカウント値の時間変化の結果を Fig. 4.25に、XO-6の比較星周りの Sky平

均のカウント値の時間変化の結果を Fig. 4.26にそれぞれ示す。

Fig. 4.25 XO-6周りの Sky平均のカウント値の時間変化

Fig. 4.25について、カウント値は約 400から徐々に減少していたが、トランジット開始直後からカウント

値が極端に上昇したことが確認された。その後は測光解析が困難だったため、プロットができなかった。
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Fig. 4.26 XO-6の比較星周りの Sky平均のカウント値の時間変化

次に GJ436周りの Sky平均のカウント値の時間変化の結果を Fig: 4.27に、GJ436の比較星周りの Sky平

均のカウント値の時間変化の結果を Fig. 4.26に示す。

Fig. 4.27, Fig. 4.28についてカウント値は約 2500となり、Fig. 4.22, Fig. 4.25といった Sky平均の時間

変化と比較すると高いカウント値となっていることがわかる。トランジット開始直後はカウント値は上昇し、

トランジット開始直後から大きくばらついたことが確認できた。
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Fig. 4.27 GJ436周りの Sky平均のカウント値の時間変化

Fig. 4.28 GJ436の比較星周りの Sky平均のカウント値の時間変化
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5 考察

5.1 主星と Sky平均のカウント値の時間変化の比較

Fig. 4.15と Fig. 4.22の曲線が異なることについて考察する。それぞれのグラフが異なっている原因を高度

変化によるものであると仮定する。Fig. 5.1は観測中の KELT-7の高度変化をステラナビゲータ 7によって

シュミレーションした結果をプロットしたグラフである。横軸はユリウス通日 (Julianday: JD)、縦軸は高度

Fig. 5.1 KELT-7の高度変化

である。Fig. 5.1について、南中時刻は約 2458078.18 JDである。この時刻は観測中の中間あたりの時刻であ

る。そのため天体およびその Sky 平均のカウント値の単調減少は南中高度だけでは説明できないと考えられ

る。

5.2 観測結果からの系外惑星の惑星パラメータ

本研究の観測でトランジットの兆候が現れた光度曲線は Fig. 4.12のみである。Fig. 4.12では第 1接触は

確認できていないが、移動平均線からトランジットによる減光とみられる現象が見られた。これが確実なトラ

ンジットの結果であると仮定した場合の半径を計算する。トランジット深さはトランジットしていない等級か

らトランジットしているときの等級の減算で計算できる。またトランジットしていないときは第 1接触以前と

第 4接触後とし、トランジットしているときは第 2接触と第 3接触の間であると定義する。2017年 11月 20

日の観測では第 1接触以前が観測できなかったため、トランジットしていないときの等級に含めるデータは第

4接触以降とする。第 2接触から第 4接触は移動平均線の変化によって目分量で定義している。第 2接触から
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第 4接触を定義した光度曲線を Fig. 5.2に示す。

Fig. 5.2 第 2接触から第 4接触を定義した光度曲線

縦軸と平行な 3本の緑線は左から第 2接触、第 3接触、第 4接触を定義している。トランジットしていない

ときの等級は 0.630± 0.067magであり、トランジット現象時の等級は 0.627± 0.034magと計算された。第

4接触以降のデータの標準偏差が 0.067magとなり、トランジット現象中のデータの標準偏差が 0.034magに

比べて 2倍程度のばらつきとなった。これにより減光等級は 0.0028± 0.0010magとなった。よって惑星半径

は 0.86+0.15
−0.15 RJ (6.1× 104 km)となった。ただし、RJ は木星半径であり、太陽半径は 696000 km、木星半径

は 71492 kmとした [30]。表 5.1は本研究と先行研究の比較である。
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Table 5.1 先行研究と本研究の比較 [8]

パラメータ 単位 本研究 先行研究

減光等級 mag 0.0028± 0.0010 0.00828± 0.00012

惑星半径 RJ 0.86+0.15
−0.15 1.533+0.046

−0.047

表 5.1より 2017年 11月 20日に観測データの減光等級は先行研究の約 0.34倍となり、惑星半径は約 0.56

倍となった。減光等級が先行研究よりも小さくなった原因として、第 4接触以降のデータのばらつきが大きく

なっていることから相対等級でも除去できないノイズが発生したと考えられる。現時点ではそのノイズの原因

は不明である。第 1接触が見られていないことを含め、再観測が必要であると考えられる。
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6 結論

本研究では岡山大学理学部望遠鏡を用いて系外惑星トランジットの追観測を行った。トランジット法による

観測と測光解析を学ぶことを目的として 2017年 11月 20日から 2018年 1月 19日までの 3日間に 3例のデー

タを取得したが、気象条件および観測機器の不慣れな操作により確定的な系外惑星トランジットの追観測には

至ることができなかった。しかし、トランジットの兆候と考えられる結果が 2017年 11月 20日の KELT-7の

観測で得られたため、測光手法などは本研究に用いた気障の組み合わせおよび一連の測光解析処理をの基本と

してよいことが分かった。今回観測した KELT-7 の減光が確実なトランジットの兆候であった場合、この減

光等級は本研究の観測により 0.0028± 0.0010magと求めることができた。また先行研究によれば減光等級は

0.00828 ± 0.00012mag であり、本研究は先行研究の 0.34倍となった。減光等級より KELT-7 bの惑星半径

は 0.86+0.15
−0.15 RJ(6.1× 104 km)であることが導けた。今回測光解析に用いたソフトウェアはMakali’iであり、

撮影画像 1枚ずつに対して手動で解析したため大量の処理には限界があった。このため現段階では解析できて

いない観測データも残されている。解析手法の効率化を図るため、測光解析を自動化するソフトウェアの開発

が今後の課題となった。
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付録

惑星パラメータの導出

トランジット観測に成功すると、いくつかの観測された系外惑星に対する惑星パラメータが導出できる。ただ

し、対象となる恒星のパラメータ (恒星質量Mstar, 光度 F , 恒星半径 Rstar)は別の手法で求まっていなけれ

ばならない。惑星パラメータを求める 4つの手順を解説する [2][29]。

(1) トランジット観測から、最初に継続時間 τ から周期 P を求める [12]。

公転周期 P について、惑星は恒星の周りを真円で回転していると仮定する。このとき軌道の半径を

a、恒星半径を Rstar、トランジット継続時間を τ とすると、比例関係から次の式が成り立つ。

P

τ
=

πa

Rstar
(3)

このとき k =
4π2

GM
とすると、ケプラーの第 3法則から半径 aを消去すると、

P =
1

k
(

πτ

Rstar
)3 (4)

となり、公転周期 P を求めることができる。ケプラーの第 3法則の導出は (3)で述べる。

トランジットを観測したある基準時刻 t1 を定める。再び起こり得るトランジット現象の時刻 t2 から

t1 を引き算した時間により公転周期を観測で確かめられる。式で表せば次のようになる。

P = |t2 − t1| (5)

(2) 明るさの減少
∆F

F
から惑星半径 Rplanet を求める。このとき、恒星半径 Rstar を用いる。

明るさの減少から惑星半径 Rplanet を求める。恒星面に惑星が完全に重なっている状態であるとき、

減光比は最小となる。恒星、惑星が真円であると仮定するとき観測される相対フラックスは
Fmin

F
は次

のように表される。

Fmin

F
=

πR2
starBstar − πR2

planetBstar + πR2
planetBplanet

πR2
starBstar

(6)

ただし、Bi は表面輝度であり、単位は [cd/m2]である。ここで Bplanet ≃ 0と見なせる。これより、

Fmin

F
≃ 1−

(
Rplanet

Rstar

)2

(7)

となる。また観測で得られる値は相対フラックス

Fmin

F
= 1− ∆F

F
(8)

である。惑星半径 Rplanet は観測値から求める場合は、

Rplanet = Rstar

√
1− Fmin

F
(9)

とすればよい。また明るさの減少と半径の関係式として、

∆F

F
　 ≃

(
Rplanet

Rstar

)2

(10)

が得られる。
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(3) 公転周期 P とケプラーの法則から、軌道半径 aを求める [28]。

周期 P を観測で得られた場合の系外惑星の軌道長半径 aを求める。ケプラーの第 3法則より公転周期

の 2乗は楕円の長径の 3乗に比例する。式で表せば、

P 2

a3
= const (11)

となる。またケプラーの第 2法則より単位時間あたりに主星と惑星が掃く面積は一定である。これは 2

次元極座標 (r, θ)について、

dS(t)

dt
=

1

2
r2θ̇ = const (12)

と書くことができる。また楕円の短径を bとしたとき、楕円の面積 πabとなるから、

πab =

∫ P

0

dS(t)

dt
dt (13)

となり、短径 bが何らかの定数の値となれば周期 P を求めることができる。

系外惑星の質量を m、恒星の質量M とすると、ポテンシャルエネルギーは V (r) = −G
Mm

r
となる。

ただし、Gは万有引力定数である。これより、ラグランジアンL は、

L =
1

2
m{ṙ2 + (rθ̇)2}+G

Mm

r
(14)

と表せる。ここでオイラー・ラグランジュ方程式より次の 2式が成り立つ。

∂L

∂r
− d

dt

∂L

∂ṙ
= 0 (15)

∂L

∂θ
− d

dt

∂L

∂θ̇
= 0 (16)

(16)について、ラグランジアンL を代入すると、

d

dt
(mr2θ̇) = 0 (17)

となる。mr2θ̇は一定となり、角運動量に等しい。よって、L = mr2θ̇ と定義する。

次に (15)について、ラグランジアンL を代入すると、

mr̈ − L2

mr3
−G

Mm

r2
= 0 (18)

となり、動径方向における運動方程式が導かれる。両辺に ṙ をかけて時間で積分すると、

1

2
mṙ2 −G

Mm

r
+

L2

mr2
= E (19)

となる。ただし、両辺はエネルギーの次元を持つため積分定数を E とした。楕円方程式を導くために、

(19)式における r についての微分方程式を解かなければならない。x =
1

r
とおく。このとき、ṙ =

ẋ

x2

となるが、このままでは解けない。(19)式は時間 tについての微分方程式なので、角度 θ による微分方

程式に変数変換する。これより ṙ =
dθ

dt

dx

dθ
=

L

mr2
dx

dθ
となるから、(13)式に代入すれば次のように整

理できる。

L2

2m
x2 −GMmx+

L2

2m

(
dx

dθ

)2

= E (20)
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ここで式変形すると、

L2

2m

(
x− GMm2

L2

)2

+
L2

2m

(
dx

dθ

)2

= E +
G2M2m3

2L2
(21)

となる。X = x− GMm2

L2
とおくと

dx

dθ
=

dX

dθ
より、

L2

2m
X2 +

L2

2m

(
dX

dθ

)2

= E +
G2M2m3

2L2
(22)

両辺を θ で微分すると、

X +
d2X

dθ2
= 0 (23)

となり、2階線形微分方程式となる。この一般解は任意実数定数を θ0, Aとすると、

X = A cos(θ − θ0) (24)

ここで、Aは単振動の振幅とみなせる。初期条件として
dX

dθ
= 0のとき X = Aとなるから、(22)式

より、

A =

√
2mE

L2
+

G2M2m4

L4
(25)

と定まる。引き続き式変形に Aを用いるとして、(24)式を 2次元極座標系に戻すと楕円方程式

r =
l

1 + ε cos(θ − θ0)
(26)

が導かれる。ただし、半長弦 l =
L2

GMm
、離心率 ε = Alと定めた。これはケプラーの第 1法則が導か

れたことに等しい。すなわち惑星は主星を焦点とした楕円軌道を描くことになる。ここで長径 aと短径

bを導く。θ0 は時刻 t = 0のときの惑星の初期位置であるため、θ0 = 0とおいてよい。θ = 0のとき、

惑星の動径距離を rmin、θ = π のとき rmax とすると、

2a = rmin + rmax (27)

となる。(26)式、(27)式より、a =
l

1− ε2
となる。ここで、離心率の定義式は ε =

√
a2 − b2

a2
である。

よって短径は b =
√
alとなる。

一方ケプラー第 2法則を角運動量 Lで表すと、
dS(t)

dt
=

L

2m
である。(13)より、

πa
√
al =

L

2m
P (28)

両辺を 2乗して式を整理すると長径 aは、

a =
3

√
GM

4π2
P 2 (29)

となる。以上より恒星質量M と系外惑星の公転周期 P が観測により既にわかっていれば、惑星の長径

aを求めることができる。
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カウント値に対する標準偏差の導出

• ショットノイズ
天体からの光子を撮像素子が受け取ることから離散的な分布とみなす。ただし光子が天体から飛来した

とき、受け取るまでに揺らぎが生じる。この揺らぎをショットノイズという。[27]ショットノイズを導

出するために、ポアソン分布モデルを使用する。ポアソン分布の定義は次のようになる。

確率変数 X が単位時間に k 回起きる場合する。定数 λ > 0に対し、確率密度分布が

P (X = k) =
e−λλk

k!
(30)

であるとき、この分布をポアソン分布と呼ぶ。ただし eはネイピア数である。ポアソン分布の一般に平

均は λ、分散は λ となり、平均と分散は等しい。なぜならば、任意の θ ∈ R に対し、ポアソン分布の
モーメント母関数はMX(θ) = eλ(e

θ−1) となるから, M ′
X(0) = λ, M ′′

X(0) = λ + λ2 となる。よって平

均はM ′
X(0) = λ、分散はM ′′

X(0)− {M ′
X(0)}2 = λとなる。また標準偏差は σ =

√
λとなる。

天体から検出した光子が検出器に入る平均粒子数を Nstar とすると、検出した際のノイズは
√
Nstar と

なる。また SN比 ( SNR)は 、

SNR =
Nstar√
Nstar

=
√
Nstar (31)

が得られる。

• AD変換単位

CCDカメラで検出される光子は CCD(電荷結合素子)表面で光電効果により電荷となり、これが各画

素のポテンシャル井戸内でこれが蓄積されてアナログ電気信号となり、さらに AD変換によりデジタル

地として出力される。カウント値は AD 変換後の離散値である。実際に検出される値は AD 変換単位

(ADU)によって求められる。ADUとは 1カウントが光電子の何個分に相当するかを示す。AD変換後

のカウント値 Ncount とし、真に検出されるカウント値 Nstar は、Nstar = Ncount × ADUで求められ

る。これより標準偏差 σ は、

σ =
√
Ncount × ADU (32)

として求められる [27]。
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